PowerPoint is a presentation program developed by Microsoft. It
provides various views and tools, with which you can build a
presentation that includes words, graphics, and media. Through

presentations, you can communicate ideas, messages, and other

information to a group of people.

PowerPoint has many objects such as pictures, shapes, SmartArt,
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screenshot, sounds and videos that you can add to your slides. You can

also add animation and different kind of transitions to the slides. We will learn about these featuresin

the chapter.

Il APPLYING THEMES —=

Themes are an in-built feature which offers you a quick way of changing the layout and design of the

presentation that you have created. Each theme hasits own set of colors, fonts and effects. It is easy to

apply a theme to a single slide, a section, or the entire presentation. Generally, it is better to use one

theme foran entire presentation so that the slides have a consistent look and feel.

To apply themes, follow the given steps:

1. ClickonDesigntab.

2. Clickonthe More drop-down arrow. All the available themes are displayed.

As you hover the mouse pointer over a theme, you can see a preview of the theme in the

presentation.

3. Select the theme you wish to apply to your presentation. The theme is applied to the

presentation.
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APPLYING THEME EFFECTS

The new theme effect is used to quickly change the appearance of the shapesin the presentation.

To apply new theme effect, follow the given steps:

1. OntheDesigntab, inthe Variants group, click
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onthe More drop-down arrow. o .
2. Select Effects from the options. A menu with l_‘g ::;“"ds* o :
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3. Select the effect you want to apply to your

presentation.
The effectis applied to your presentation.
APPLYING THEME BACKGROUND STYLES
To apply new theme background style, follow the given steps:

1. On the Design tab, in the Variants group,

clickonthe More drop-down arrow.
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2. Select Background Styles from the options. flt @
. . . D ects >
A menu with various background option l_{@ :dgm.,dst,.s =

appears.
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3. Select the background you want to apply to FAMOUS MO}

your presentation. 3

The background style is applied to your
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Il CHANGING SLIDE BACKGROUND —=

You can change the appearance of a slide by
changing its background color, shade, pattern, or

texture. You canalso use a picture as background.

To change the background style, follow the given

steps: FAMOUS MONUMENTS OF IN

1. On the Design tab, in the Customize group,
choose Format Background option. The
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right of the window.
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INSERTING SHAPES —=

We canalsoinsertvarious pre-designed shapes using Shapes tool.

To insert shapes on the slide, follow the given

steps:

1. Clickonthelnserttab.

2. Click on the Shapes If*;’ option in the
lllustrations group. The expanded list of
shapes appears.

3. Choose the required shape you want to
insert.

4.

Now dragthe mouse pointer on the slide to draw the shape of the required size.

INSERTING SMARTART —=
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PowerPoint has an important feature called SmartArt. SmartArt graphic is a visual representation of

information and ideas through graphics, lists and designs which contains text.

ToinsertaSmartArtinyourslide, follow the given steps:

1.
2.

Clickonthe Insert tab.

Click on SmartArt ﬁ option in
the Hlustrations group. A Choose
aSmartArt Graphicdialog box appears.

Choose a SmartArt from the given

categories.

Click OK button. The SmartArt is

inserted on the currentslide.

Click on [Text] in each individual shape

and type the desired text.
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To delete the entire SmartArt, click its border and press the Delete key. To
delete ashape, click on only that shape and press the Delete key,.
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2. Slide Pane : The slide pane displays an enlarged view of the current slide. This is your work area.

You can add text, pictures, SmartArt, videos, audio files etc. to your slide here.

3. Notes Pane : The notes pane is used to type notes relevant to a particular slide. You can refer to

these notes for the slide while giving your presentation.

OUTLINE VIEW .
[E8) Slide Sorter
. . . . E'E’S:‘:ps g: dM'M“ z":""“ Notes Zoom Fitto Colo/ Window Mac
Outline View e shows the text onthe slides in the gl Lt A Il st OO
flew n =
slide navigation pane. This view allows you to |, mw, .

e O ——
quickly edit your slide text, and view the text of = &&=~ T p

multiple slides ataglance.

«
slide1of3 [2 English (United States) = Notes B 55 @ T -—+ + 40% 3

SLIDE SORTER VIEW Outline View

Slide Sorter View s displays a miniature view of

File esign nsitions  Animations. L ignin 9. Share
E‘[@E :‘jmi QD 1= color 0 B Amangean = :

Sorter
. . . . . Normal Outline Slide Notes Reading Slide Handout Notes Zoom Fitto -Gnys = N-I %‘( = Switch Macros
all the slides in a presentation. In Slide Sorter View, Vo e e s O i, B o T

you can change the order of the slides. The

advantage of this view is that you can see all slides EO,.\“"""’Q‘

on the screen and you can move, delete, edit and ‘ ’
recognize these slides easily. A thick border

appearsaroundthe selectedslide.

NOTES PAGE VIEW

You can add notes to the slides in your presentation.
If you click the Notes Page View @ you will be taken

to a page view with the slide in the top half and a

text box below it to add your notes. These notes are

useful to help you remember important points and .- — e ——

Notes Page View
are called Speaker's Notes. They cannot be seen by
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the audience.

READING VIEW

Reading View = allows you to view a presentation
not in full screen slide show view, but in a window

with Title Bar and Status Bar with simple controls that

make the presentation easy to review.

Reading View
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O  Entrance : It makes the text and
object enter the slide with an

effect.

O  Emphasis : It is used to highlight | ] F@

?

the key points in text or an object
thatisontheslide.

O  Exit: It makes the text and object
. . . Animating Text and Objects
exit the slide with an effect.

O Motion Path : It adds an effect that makes text or an object moves within the slide in a
specified pattern or direction.

4. The object will now have a small number next to it to show that it has an animation. Also, in the
slide pane, the slide will now have a star symbol next to it indicating that the animation effects

have been applied to the slide.

You can add animations to other texts or objects on the same slide. They will be numbered

2,3....andsoon,and willruninthat sequence.

5. Clickonthe Preview optionto preview yourslide
OR

Click Ctrl+F5 keyboard shortcut, to preview the transition of all the slides.

You can add more than one animation to the same object by clicking drop-down
arrow of the Add Animation button in the Advanced Animation group.

ADJUSTING THE ANIMATION TIMINGS

PowerPoint also allows us to adjust the time of animation or the durationand wheniitis to be triggered

during the slide show.
To specify when an animation should start, follow the given steps:

1. Onthe Animation tab, click the down arrow of the Start box in the Timing group and choose the

required option from the following:
O OnClick:The animation begins when you click mouse on the slide.
O  WithPrevious: The animation begins at the same time as the previous animationin the list.

O AfterPrevious: The animation beginsimmediately after the previous animation ends.
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Click the drop-down arrow button on its right side to expand the list Animation Pane ¥ X
) Play From -
of options. 1 Tl 1 FAMO... [
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To remove an animation, click on the animation number to — —

remove. The number box gets highlighted. Press the Delete key.

Removing an Animation

Il| SLIDE TRANSITIONS —=

Transitions are the special visual effects that are added to a slide when you move from one slide to the

next in a presentation. You can make a slide fade out into the new slide or a new slide to cover up the

previous slide. There are many such transition effects available in PowerPoint.

APPLYING SLIDE TRANSITION

To apply a transition to a slide in a PowerPoint

presentation, follow the given steps:

1. Select the slide from the Slide Navigation

Pane to which you want to apply transition.
Click on the Transitions tab.

Click on More button in the Transition to
This Slide group.

A drop-down gallery opens with the
various transition effect options.
PowerPoint has following three categories

of transition effects to choose from:

O Subtle : These transition effects are

very simple and basic.

O Exciting : These transition effects are
more complex than subtle effects. This
category has transitions which are

strong.

OF

e n: ign View Q Tellme.. Signin S Share
D n o <), Sound: [NoSound] ~ Advance Slide
\:I ]| = - (© Duration: 0200 - ] On Mouse Click
None Cut Fade Push
Previe: W Transition to This Slide

Effect
ptions - T3 Apply To Al After: |00:00.00 3
Timing S

RED FORT

Red Fort, also called Lal Qal'ah, also

3 spelled Lal Kila or Lal Qila, Mughal fort
* ' ql in Old Delhi, India. It was built by Shah
Jahan in the mid-17th century and
remains a major tourist attraction. The
@ fort was designated a UNESCO World
Heritage site in 2007. ;
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= é‘} uick Revision

» PowerPoint presentation is also known as Slide Show.

» Different views in PowerPoint are Normal View, Slide Sorter View, Reading View and Slide Show

View.
» Theme is the look, colour, and graphics that the slides in your presentation have in common.

» Transition effects are the movements that occur when one slide advances to another in Slide Show

view.
» Animations are predefined special sound or visual effects that you can add to objects on a slide.

» There are four options to animate text or objects: Entrance, Emphasis, Exit & Motion Path.

» You can add more than one animation to the same object. 4|

- PRACTICE -

Q.Tick [ the correct answer

1 A, displays the slide in full screen mode.
a. Slide Show b. Slide Sorter c. Outline

2. allows you to add text and view information along with the slide you want to share.
a. Slide Pane b. Outline Pane c. NotesPane

3. Whichofthe following effects determines the entry and exit style of aslide?

a. Animation b. Sound c. Transition

4. Whichoftheseisnotaview?

a. Zoom View b. NormalView c. SlideSorterView
D s effects can be added to aslide to advance to the next slide.
a. Transition b. Animation c. Bothaandb
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4. Whatisslidetransition?

5. Describe the different methods to advance aslide in a presentation.

CLLL @ Concept Based Questions mmm=

1. Parulhas made apresentation of 5slides. She wants to apply the same background colour to
all the slides. Which option will she use to perform the given task?

2. Surabhiwantsto preview the transition of all the slides in her presentation. Suggest her as to
which shortcut key combination she should use to play the animation.

Q Match the following
ColumnA ColumnB

1. Themes Special visual effects that are added to a slide when you move

fromoneslidetothe nextina presentation.

2. Background Styles Displays a miniature view of all the slides in a presentation.

3. Transition Predefined special sound or visual effects that you can add to

objectsonaslide.

4. Slide Sorter View Predefined combination of colors, fonts and effects.

5. Animation Enhances the contrast of background with text.
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